
MOS Template 101  
 
Este manual es una guía paso a paso de como hacer tus propios plantillas de Mambo. Esta dirigido 
a los novatos que están por ahí peleando por obtener los resultados que quieren, o que 
simplemente no pueden poner todo junto, de todos los demás manuales, en cualquier parte. El 
software usado en este manual es Photoshop 7, Deamweaver MX y Mambo Stand Alone 
Server que se puede conseguir en http://mosforge.net/projects/msas/ gracias a 
mambosolutions.com 
 
NOTA DEL TRADUCTOR!!! En muchos de los casos se menciona que se abran ciertos menús y se 
seleccione alguna de las opciones. Yo no cuento con los programas en español, así que puse una 
traducción literal de los términos y entre paréntesis puse el original en ingles. Si alguien cuenta con 
las versiones en español y quiere ayudar avísenme para que lo cambiemos a lo correcto que 
aparece en los programas. Y si encuentran algo que no este muy entendible por la traducción que 
hice, también avísenme para que lo podamos cambiar. También puede ser que estén tentados de 
cambiar algunas cosas en el código a español, no lo hagan!!!!, recuerda que Mambo esta 
diseñado para todo el mundo y desafortunadamente el ingles es la lengua que se usa en cuestiones 
globales. Solamente haz cambios si realmente sabes de programación. 
 
Así que tomen una taza de café (una grande) y empecemos! 
Primero unas notas importantes! 
Por favor léanlas, te va a dar un mejor entendimiento de que es lo que estas a punto de hacer, así 
podrás decidir si este manual es correcto para ti.  
 
Que esperar de este manual?  
Este manual no es bajo ningún concepto un template creado de manera profesional, solo esta 
hecho para que funcione! 
  
No te va a enseñar como ser un mejor diseñador… 
 
No va a hacer ninguna validación de CSS, html, xml o cualquier cosa como estas… 
 
Es solamente una forma simple y llana de construir tu propio template. 
Si estás buscando atajos, y formas fáciles de hacer las cosas,  
entonces debes ser ya un profesional en este momento, así que este manual no es para ti. 
 
Entiende!  
Yo no lo sé todo, francamente nunca he conocido a alguien que lo haga.  
Así que si encuentras errores, menciónalos para poder corregirlos, pero no te enojes, porque 
después de todo soy humano. 
 
Por favor ten en mente que nosotros tenemos nuestra forma de hacer las cosas, voy a hacer lo 
mejor para que este manual sea accesible para todos, sin embargo, sé comprensivo y ten en 
cuenta que puedo no saber todo, o mostrarlo todo, (no que no quiera hacerlo, sino que hay cosas 
que son imposibles de hacer). No te impacientes, si me olvido de mencionar algo, solamente 
recuérdamelo y lo arreglaré. Si crees que estoy haciendo algo incorrecto, o si conoces una mejor 
forma de explicarlo, házmelo saber, yo haré los cambios y te daré el crédito a ti. 
 
Antes de que empieces!  
El paso 1 es la planeación, las decisiones son el factor clave en tener éxito, una vez que te hallas 
decidido mantente firme a tu idea si es que empiezas a divagar, tu creación no mejorará, sino que 
de hecho será peor. Los colores son un factor principal en cualquier template, tener muy poco los 
hace aburridos y poco atractivos, tener mucho color va a ser que sea confuso para tu usuario final, 

http://mosforge.net/projects/msas/


y puede llegar a ser pesado para los ojos. 
 
Así que decide que es lo que crees que es mejor para la imagen que quieres conseguir. Piensa en 
quienes van a ser los usuarios finales del sitio. Tus visitantes son en quienes te tienes que 
concentrar, no tanto en lo que tú piensas, sino en lo que ellos piensan. Así que haz tus decisiones 
de manera inteligente, visita sitios de intereses similares para que veas como se ven. Anota tus 
ideas en un papel, te va a servir para mantenerte enfocado en la tarea. 
 
He visto algunos muy buenos diseños que resultan mal porque, el diseñador empieza a desviarse 
del plan, agregando partes y piezas aquí y allá, es una cosa buena, siempre y cuando sea parte de 
tu concepto original. 
 
Una vez que pierdes ese enfoque, puede ser que termines perdido en el Photoshop, con todas las 
cosas que ofrece y todos esos efectos, que te gustaría usar, correcto?... Incorrecto. La peor cosa 
que te puede pasar es cuando empiezas a estar demasiado creativo. No estoy diciendo que la 
creatividad sea mala, pero usarla mucho en un solo diseño puede ser considerado un error. 
 
Como funciona? 
En este manual te iré guiando paso a paso lo mejor que pueda, pero tu necesitas hacer decisiones 
por cuenta propia, y experimentar un poco por ti mismo. A pesar de que esta guía son 
instrucciones paso a paso, te invito a que hagas cambios si lo crees conveniente. Después de todo 
estas aquí para aprender y no para seguir lo que yo hago. Otra cosa importante es la paciencia, y 
dar un poco de perdón a tu PC, las cosas pueden no salir como a ti te gustaría que fueran… 
 
 Así que por favor no azotes tu cabeza en el teclado y grites, 
 Eso no te va a llevar a ningún lado, solamente inténtalo una y otra vez, hasta 
que obtengas el resultado que quieres. 
 
Dicho esto, esperemos que trates de hacer tu mejor esfuerzo. 
Si tienes problemas entonces haz uso de los foros, con gusto van a responder tus preguntas. 
También me gustaría ver tu creación una vez que hayas terminado, así que por favor regístrate 
como usuario y pon una liga a tu página. Ayuda a otros a conseguir lo que tu haz hecho. 
 
OK, vamos a empezar 
 
Lo primero es que vas a necesitar graficas para tu template, así que inicia el Photoshop y vamos a 
meternos en eso. 
 
Asumo que tienes los conocimientos para moverte un poco dentro de Photoshop, así que sabes 
donde encontrar cosas como capas, colores, etc. Si no lo sabes, la mayoría de las cosas se 
encuentran en el menú “Window” (menú superior), solo selecciónalo y mágicamente aparecerá en 
tu pantalla. 
 
PISTA! 
La mayoría de las herramientas en Photoshop pueden ser accesadas usando atajos con 
las teclas, para explicar como funciona, cada vez que veas algo como (Ctrl + Alt + Shift 
+ N), esto significa que debes mantener presionada la tecla Ctrl (Control), y mientras 
mantienes Ctrl presionada y presionas Alt, manteniendo presionadas Ctrl y Alt, 
presionas y mantienes Shift, y por último mientras presionas Ctrl, Alt, Shift, presiona 
N… 
 
Si esto parece confuso, pero no te preocupes, iras agarrando práctica en hacerlo, o 
puede simplemente, hacerlo de la forma antigua dándole clic a las cosas. Los atajos de 



teclas solamente están diseñados para ahorrar algo de tiempo. 
 
Vamos a empezar creando un nuevo documento. 
 
Voy a usar uno de 760 píxeles de ancho (eso es suficiente para que salga completo en cualquier 
pantalla de 800 x 600 de resolución). El template actual tendrá un ancho variable, que quiere decir 
que se va a estirar para cubrir la resolución de la pantalla del usuario, pero no será menor a 760px. 
 
La altura realmente no importa, pero para tener una buena zona de trabajo, usaré 600 píxeles. 
 
Para crear un nuevo archivo, ve a File (Archivo) >> New (Nuevo) (Ctrl+N) 
 

 
 
OK, ahora ya tenemos una pagina en blanco en Photoshop y es tiempo de hacer algo de magia. 
Primero voy a establecer algunas guías para ayudarme en el proceso de diseño, como debes saber 
un sitio básico de Mambo consiste en un encabezado(header), módulos izquierdos (left modules), 
módulos derechos (right modules), contenido principal (main content) y un pie de página (footer). 
Voy a establecer mis guías para tener un encabezado con una altura de 180 px, y los módulos 
izquierdo y derecho de 150 px y un pie de página de 30 px. Para establecer las guías toma la 
herramienta de mover (Move Tool) (V) 
 

 
 
Después dale clic a la regla, y mientras lo mantienes presionado jálalo hacia abajo o hacia la 
derecha y así estarás creando una nueva guía. Si no puede ver las reglas en la parte superior y 
derecha, ve a View (Ver) >> Rulers (Reglas) (Ctrl+R)  
 

 
OK, el acomodo (layout) básico de mi concepto se debe ver así  



 
 
No necesitas realmente establecer las guías si no quieres hacerlo, pero en mi opinión hace que el 
proceso de diseño sea más consistente y eficiente, sin mencionar que lo hace más fácil.  
 
PISTA! 
Las guías de diseño pueden ser molestas, para esconderlas ve a View (Ver) >> Extras 
(Ctrl+H) 
 
Ahora es un buen momento para salvar. No puedo dejar de mencionar lo importante que es salvar, 
así que hazte un hábito de salvar tu archivo bastante seguido. Yo te iré recordando mientras vamos 
avanzando, pero trata de hacerlo por ti mismo, y que sea parte de la naturaleza de tu trabajo. 
Para salvar ir a File (Archivo) >> Save (Salvar) (Ctrl+S) 
 
Listo para empezar? OK, ahora vamos a hacerlo. 
 
Llego el momento de las decisiones. Hay que decidir que tipo de imagen quieres conseguir, decide 
la estructura del sitio antes, va a hacer tu vida más fácil y junta todos los materiales necesarios, por 
ejemplo fotografías de stock, iconos, etc. 
 
Vamos a empezar con la parte divertida. 
 
Yo generalmente empiezo con el encabezado y de ahí voy desarrollando lo demás. En mi opinión el 
encabezado es la parte más importante del sitio, porque en la mayoría de los casos es la parte más 
visible. 
 
OK, vamos a empezar creando un nuevo grupo de capas, esto va a hacer que el administrar tu 
diseño sea un poco más organizado y será más fácil para ti encontrar las cosas, sobre todo cuando 
se diseñan plantillas complicados. 
 
Para crear un nuevo grupo de capas ve a Layer (Capa) > New (Nuevo) > Layer Set (Juego de 
Capas) o da clic en el icono de New Set (Nuevo Juego) en la parte inferior de la paleta de capas. 
 

 
 
Si no puedes ver la herramienta de capas ve a Window (Ventana) > Layers (Capas) y con eso se 
podrá ver. Ya lo tienes? Bien, crea un grupo de capas y llámalo Header (o Encabezado, el nombre 
puede ser cualquier cosa, pero se usan estos nombres para hacerlos más identificables). Para poder 
cambiar el nombre del grupo, solamente dale doble clic en el nombre y escribe uno nuevo. El menú 
de capas debe parecer algo así: 
 



 
 
Ahora necesitamos crear una capa dentro del grupo, hazlo seleccionando el ser y dándole clic en la 
pequeña flecha azul al lado del nombre, que debe estar apuntando hacia abajo cuando el grupo 
esta seleccionado.  
 

 
 
Ahora ve a Layer (Capa) > New (Nuevo) > Layer (Capa) (Shift + Ctrl + N) y tu menú de capas 
debe verse así, y solo dale un nombre y déjalo así como esta.  
 

 
 
OK, ahora que hemos creado un nuevo grupo y una capa, vamos a la parte mágica. Selecciona la 
capa recién creada, cuando una capa esta seleccionada debe estar resaltada con un color distinto, 
entonces busca la herramienta de Marco Rectangular (Rectangular Marquee) (M) 
 

 
 
Con la herramienta de Marco Rectangular, selecciona la porción correspondiente al encabezado en 
tu plantilla, de esta forma:  
 

 
 
Ahora es el momento de seleccionar algunas combinaciones de colores. Voy a hacer el encabezado 
con una series de colores que van del verde claro al blanco, para hacer esto selecciona primero tus 
colores y darle clic en la caja de colores.  
 

 



Así es como se tiene que ver el menú de colores: 
 

 
 
No voy a entrar en detalles sobre el uso de colores en este manual, porque simplemente hay 
muchas combinaciones y formas de seleccionar un color, por ahora nos vamos a apegar a usar los 
colores básicos que son seguros en Internet, para hacer esto, asegúrate de seleccionar el cuadro 
que dice “Only Web Colors” (Solo usar colores Web, en un círculo naranja en la imagen de arriba), 
esto en vez de usar la barra de colores y la vista previa para poder conseguir el color que quieres. 
Se deben establecer dos colores, el Frente (Foreground) y la parte de atrás (Background), así que 
para tener una sombra que vaya de verde a blanco, se necesita establecer el frente en verde y la 
parte de atrás en blanco, así: 
 

 
 
Ya lo conseguiste? Bien, ahora vamos a seleccionar la herramienta del degradado (gradient tool) 
 

 
 
Ahora arrastra la herramienta de degradado de la parte superior a la inferior de tu selección, y 
asegúrate de hacer una línea recta.  
 

 
PISTA! 
Para restringir el movimiento a líneas rectas, mantén presionada la tecla (Shift) 
mientras lo arrastras. 
 
Una vez que lo haya hecho, debes tener algo que se vea así:  
 



 
 
Bien, no? Ahora vamos a aderezarlo un poco, vamos a poner algunos cuadros blancos encima de 
esto. Para hacerlo vamos a usar la técnica de patrones. Para poder hacerlo, vamos a empezar 
creando un nuevo documento (Ctrl + N) con las siguientes características.  
 

 
Nombre: Cuadro _ blanco 
Ancho: 3 píxeles 
Alto: 3 píxeles 
Resolución: 300 píxeles/pulg. 
Transparente 
 
 
 
 
 

En tu nuevo documento selecciona el blanco como el color del frente (o el color que hayas 
seleccionado como el fondo en el degradado del encabezado)  
 
Acércate (Zoom) lo más que puedas, para que puedas ver tu documento. (Para acercarse usa la 
herramienta de lupa(Z) y después selecciona la herramienta de lápiz (Pencil Tool) (B).  
 

 
 
Establece el ancho del lápiz en 1 px, la parte superior se debe ver como aparece acá:  
 

 
 
Ahora pon un solo cuadro en el medio del área para que se vea así  
 

 
 
Ahora vamos a convertirlo en un patrón, para hacerlo ve a Edit (Editar) > Define Pattern (Definir 
Patrón), ponle un nombre y dale OK. 
  

 
 



Ya hemos terminado con esa parte, cierra el documento (no hay necesidad de salvarlo) y regresa a 
tu plantilla. 
 
OK, ahora vamos a poner el patrón en el encabezado con el degradado, hazlo seleccionando la 
capa de atrás y después ve a Edit (Editar) > Fill (Rellenar), y selecciona el patrón nuevo (el 
cuadrado blanco en mi caso) 
  

 
 
Puedes intentar jugar un poco con las características, como pueden ser el modo de mezcla 
(blending mode) y la opacidad (opacity), no voy a estar explicando todas las diferencias entre los 
distintos modos de mezcla, porque es un tema muy extenso. 
 
Yo estoy usando el modo de mezcla normal y una opacidad de 50% y aquí esta el efecto que 
consigo. 
  

 
 
Ahora puedes deseleccionar el área, para hacerlo puedes ir a Select (Seleccionar) > Deselect 
(Deseleccionar) (Ctrl + D). Y Ahora es momento de salvar tu trabajo File (Archivo) > Save (Salvar) 
(Ctrl + S).
 
OK, por un momento vamos a dejar la parte del encabezado y hacer que algunas cosas 
sucedan, vamos a regresar al encabezado después. 
  
Voy a empezar haciendo un nuevo grupo de capas que se llamará Izquierdo, y después una capa 
que se llamará izquierdo_atras, para que el menú de capas se vea así: 
  

 



PISTA!  
Puedes modificar el orden de las capas o de los grupos de capas haciendo clic y 
manteniendo presionado el fólder o el icono de vista en miniatura, y después moverlo 
hacia arriba o abajo a la posición deseada, así como mover las capas entre los grupos. 
(La posición de la capa puede afectar su posición al frente o atrás en relación a las 
demás capas o grupos) 
  
Ahora que tenemos un nuevo grupo de capas y una capa vamos a ponerlos en uso. Selecciona la 
capa izquierdo_atras y después selecciona la herramienta de marco (M), y selecciona la porción 
izquierda completa usando las líneas de guía para ayudarte, y tiene que verse así:  
 

 
PISTA!  
Usa las propiedades de Ajustar para hacer más fácil las selecciones, lo puedes 
encontrar en Ver (View) > Encajar (Snap) (Ctrl + Shift + ;) Si tienes el Encajar (Snap) 
activado todas las selecciones y los movimientos se ajustaran al punto más cercano, 
esto lo puedes configurar usando Ver (View) > Encajar (Snap) > Propiedades (Settings) 
 
Ahora vamos a llenar el área con un color, primero selecciona el colores que quieras para el frente, 
yo estoy seleccionando el gris claro.  
 

 
 
Ahora toma la herramienta del Bote de Pintura (Paint Bucket Tool) (G)  
 

 
 



Asegúrate de tener la capa correcta seleccionada, y dale clic dentro del área seleccionada, después 
de eso debes de tener algo que se vea así:  
 

 
 
Ahora vamos a deseleccionar el área con Seleccionar (Select) > Deseleccionar (Deselect) (D) 
 
Ahora voy a agregar algo de estilo de capas ahí, solo para adornarlo un poco. Los estilos pueden 
ser una herramienta muy poderosa, y al mismo tiempo son algo muy complejo y toma tiempo el 
dominarlas, así que solamente experimenta con ellos y aprenderás que es lo que hacen en poco 
tiempo. 
 
OK, vamos a agregar el estilo de trazo a nuestra capa, hazlo seleccionado esa capa 
(izquierdo_atras) y da clic en el botón de estilo de capa, y selecciona trazo de la lista.  
 

 
 
Yo estoy usando las características de abajo, pero estas bienvenido a experimentar un poco más 
con el.  
 

 
 
Se ve bien así como esta, pero todavía hay espacio para mejorar, así que agregare otra capa al 
grupo de la izquierda (Ctrl + Shift + N) Voy a llamar la capa (cua_oscuro)  



 
 
Ahora toma la herramienta de marco rectangular y selecciona el área que se va a rellenar, 
selecciona un color y rellénalo. Si después decides agregar algo de estilo a la capa, hazlo. Yo hice 
un pequeño rectángulo vertical a la derecha de mi capa (izquierdo_atras), después le agregue un 
trazo blanco de 1 pix., y esto es con lo que termine.  
 

 
 
Con suerte habrás conseguido lo que estabas buscando hasta el momento, así que adelante y salva 
tu trabajo (Ctrl + S) Si todavía tienes animo de más continua leyendo y vamos a darle. 
 
Bueno, se ve bien hasta el momento, cierto? Puede ser que quieras usar lo que hemos 
hecho hasta el momento y hacerlo una plantilla, pero no estar más atractiva ahora? 
 
OK, entonces vamos a regresar al grupo de capas del encabezado, y se hace dando clic en la 
pequeña flecha que esta a un lado del icono del fólder, esto lo va a abrir. Ahora vamos a crear una 
nueva capa en ese grupo, yo voy a llamar el mió (barra_nav) Voy a usar ese para mostrar el 
camino en la plantilla. Ahora que tienes una nueva capa es momento de rellenarla con algo, así que 
empieza tomando la herramienta de marco y selecciona el área del alto que quieres que sea el 
texto del camino, puedes usar las líneas de guía, esto es lo que obtuve:  
 

 
 
Ahora selecciona un color para rellenarla, yo estoy escogiendo un relleno degradado, así que debo 
de seleccionar dos colores. Voy a hacer el degradado que ira del blanco al naranja, así que mi color 
del frente es blanco y la parte de atrás es naranja.  
 

 
 
Ahora toma la herramienta de relleno degradado (G) 
 
PISTA! 
Para que cambiar entre distintas herramientas dentro del mismo menú presiona (Shift) 
y la letra correspondiente en tu teclado, p.e. (Shift+G) te va a cambiar entre el Relleno 



con Cubeta y el Relleno Degradado.  
 
Con la herramienta del relleno degradado arrástrala de arriba a abajo de tu área seleccionada.  
 

 
 
Ahora puedes deseleccionar el área, para hacerlo puedes ir a Select (Seleccionar) > Deselect 
(Deseleccionar) (Ctrl + D). Ahora vamos a agregar un estilo de trazo a mi capa (barra_nav), hazlo 
seleccionando la capa y después da clic en el botón de agregar estilo, que en mi caso es el de 
trazo, pero recuerda que es conveniente que experimentes con los efectos que existen. Estoy 
usando un trazo de 1 pix, de color gris (igual al que uso en la capa cua_oscuro) Después de hacer 
esto tengo que arreglar algunos asuntos de alineado porque la barra se ve fuera de lugar, así que 
tengo que moverla 1 pix hacia arriba (el ancho del trazo) y así con eso se alinea muy bien. La 
forma mas sencilla de mover algo en pequeños incrementos es usar algo llamado “nudging” (n.t. 
que se traduce como codazo, pero en realidad es empujar algo ligeramente), para empujar la barra 
arriba 1 píxel toma la herramienta de agarrar (V) 
 

 
 
Y después aprieta la tecla con flecha hacia arriba una sola vez. 
 
PISTA! 
Con la herramienta de mover seleccionada, puede mover tu elemento (la capa o juego 
seleccionado) 1 píxel en cualquier dirección con las teclas de las flechas. 
 
Aquí esta el resultado, se ve bien no?  
 

 
Correcto, ahora démosle un poco de vida a nuestra plantilla, así que verifica si tienes 
suficiente café, y vamos a entrar en acción. No te olvides de salvar tu trabajo (Ctrl + S) 
 
Yo estoy escogiendo una siempre popular mariposa para mi diseño, tú puedes escoger algo 
diferente; esto depende completamente de ti. OK, vamos a trabajar en una imagen o foto (o por lo 
menos en una parte de ella) para el encabezado. 
  
Ahora viene la parte difícil, necesitas la foto de algo, pero no la tienes. Que lastima. Yo tengo 
muchas fotos de stock en CD’s, que he comprado a lo largo de los años, así que para mi es fácil el 
obtener las fotos que necesito. Pero afrontemos la realidad, no se compran fotos de stock a menos 
que te ganes la vida haciendo cosas de diseño, porque las buenas fotos de stock pueden llegar a 



costar mucho dinero, así que vamos a usar algunas gratuitas. 
 
En mi opinión una de las mejores galerías de fotos stock gratuitas es Stock.Schng 
(http://www.sxc.hu) que es de donde obtuve la foto de la mariposa que planeo usar, que la puedes 
bajar aquí http://sxc.hu/browse.phtml?f=view&id=141508 (nota! Tienes que abrir una cuenta 
para poder obtener la fotografía a tamaño completo, así que regístrate, es fácil y 
gratis). 
 
OK, ahora que tienes la foto que quieres, vamos a incorporarla a tu diseño. Abre la foto en 
Photoshop con Archivo(File)>Abrir(Open) (Ctrl + O) como te habrás dado cuenta, las imágenes son 
bastante grandes, por ejemplo la mariposa mide 1147 x 1001 píxeles, que es muy grande. Voy a 
cortar el tamaño a 400 píxeles de ancho, que se puede hacer seleccionando Imagen(Image) > 
Tamaño Imagen (Image Size)  
 

 
 
OK, ahora se necesita que pongas esa foto en el archivo de la plantilla. Primero selecciona el área 
entera yendo a Seleccionar (Select) > Todo (All) (Ctrl + A), después cópialo con Editar (Edit) > 
Copiar (Copy) (Ctrl + C). Ahora puedes cerrar la foto (no hay necesidad de salvarla) y regresa a tu 
plantilla. Una vez de regreso crea otro juego de capas, y vamos a llamarla logo. Una vez que tienes 
hecho el juego, asegúrate de esta en la parte de arriba del menú y que esta seleccionada, tu menú 
se debe ver así: 
  

 
 
Ahora pega la foto de la mariposa, lo puedes hacer por medio de Editar (Edit) > Pegar (Paste) (Ctrl 
+ V).  De acuerdo, ahora que tenemos la foto, vamos a necesitar quitar todas las partes que no 
son necesarias para dejar solamente la mariposa. Hay muchas formas de hacer eso, puedes usar 
las mascaras, el borrador, etc. Yo voy a usar la herramienta del Laso Magnético (L), para 
seleccionarla y deshacerme del resto. 
 



 
 
Así que toma el laso magnético, y empieza a seleccionar el contorno de la mariposa. Esto lo puedes 
hacer seleccionando en alguna parte del borde y arrastra la herramienta todo alrededor de la 
mariposa, manteniéndote muy cerca del borde, y deja que el laso haga su trabajo. Se ajustara de 
manera automática por ti, si no lo hace entonces dale clic donde el laso no haga la auto captura, es 
algo relativamente sencillo, solamente hay que desarrollar la practica para hacerlo.  
 

 
 
Así es como se ve mi selección.  
 

 
 
Ahora para quitar todo excepto la mariposa, necesitas invertir la selección por medio de Seleccionar 
(Select) > Inverso (Inverse) (Shift + Ctrl + I). Una vez que lo hayas hecho, solamente bórralo con 
la tecla Suprimir (Delete), y después lo de-seleccionas (Ctrl + D). 
 
Listo, ya tienes tu mariposa, ahora lo que se necesita es ajustar el tamaño y la posición. Yo voy a 
poner la mía en la esquina superior izquierda, tú puedes ponerla en donde quieras. 
 
OK, para mover las cosas alrededor, todo lo que tienes que hacer es seleccionar la herramienta 
para mover, después seleccionar la capa que quieres mover y dar clic y mantener mientras 
arrastras al lugar en el que lo quieres. 
 
Para modificar el tamaño de una capa o de un juego de capas, primero se selecciona, y después 
vas a Editar (Edit) > Transformación Libre (Free Transform) (Ctrl + T). La herramienta de 
transformación te va a permitir el que modifiques el tamaño y rotar. Para cambiar el tamaño toma 
la esquina de la caja y arrástrala hacia adentro o afuera. Si no lo haces por la esquina corres el 
riesgo de distorsionar la imagen (n.t. En caso que te ocurra el que se distorsione la imagen, 
recuerda que puedes ir varios pasos hacia atrás usando el Editar (Edit) > Deshacer (Undo) (Ctrl + 
Z))  
 



Ahora, usando las herramientas de mover y transformar, dale el tamaño y mueve a la mariposa a la 
posición que mas te guste. La mía se ve así:  
 

 
 
Ahora voy a agregar algunos estilos para que tenga una Sombra Externa (Drop Shadow), Sombra 
Interna (Inner Shadow), y un Brillo Externo (Outer Glow) con las siguientes propiedades: 
  

 
 
Debes tratar de experimentar con diferentes estilos para poder conseguir lo que tú realmente 
quieres, o simplemente puedes dejarlo así como esta. El resultado final del mió se ve así: 
  

 
 
Ahora es un buen momento para salvarlo (Ctrl + S). 
 
Vamos a hacer un logo rápido; no voy a hacer nada muy sofisticado aquí, ya que este manual ya es 
lo suficientemente largo así como esta. Solo voy a agregar algo de texto. Vamos a tomar la 
herramienta de Texto Horizontal (Horizontal Type Tool)  (T). 
 

 
 
Después selecciona una fuente, tamaño y color usando el menú que se encuentra en la parte 
superior 
  

 
 



Después da clic en cualquier parte que tu quieras que esté el texto y escribe, y cuando termines 
solamente dale clic a la paloma que se encuentra en la barra superior. 
  

 
 
Después modifica el modo de mezcla a Deferencia (Difference) para algunos de los cuadros blancos 
sean visibles en el texto y el modo de mezcla de la mariposa a Luz Dura (Hard Light)  
 

 
 
El resultado final se debe ver así:  
 

 
 
Llego el momento de volver a salvar nuestro trabajo (Ctrl + S) y continuar hacia otra parte de la 
plantilla. 
 
OK, necesitamos algo a la derecha de nuestra plantilla para que los módulos tengan algún lugar en 
el cual colocarlos. Solamente voy a hacer una figura simple, nada sofisticado, quiero que la imagen 
sea consistente. Vamos a empezar creando un nuevo juego de capas, y después crear una nueva 
capa dentro de ese juego, la mía es fondo_derecho, así que ahora mi menú de las capas se ve así: 
 

 
 
OK, vamos a tomar la Herramienta de Laso Poligonal (L) y haciendo uso de las guías para ayudarte, 
haz una selección (forma) que a ti te parezca bien. 
  



 
 
Mantén presionada las tecla de Mayúsculas para restringir el movimiento a líneas derechas o de 45 
grados. Aquí esta la selección que yo hice, fíjate que hay un pequeño ángulo de 45 grados en la 
parte superior, tu puedes hacer si quieres un rectángulo normal, yo solamente quería un poco mas 
de detalle. 
 

 
 
OK, ahora que tienes tu área delimitada, asegúrate de tener la capa correcta seleccionada, y 
después agarra tu herramienta Cubeta de Pintura (Paint Bucket Tool) (G) y llénalo con el color que 
escojas. Una vez hecho esto lo puedes deseleccionar (Ctrl +D) Yo también le voy a agregar un 
estilo de trazo, estoy usando 1 píxel de gris oscuro, y una vez que termine voy a tener algo que se 
ve así: 
  

 
 
Ahora es un buen momento de salvar el trabajo (Ctrl + S), bien, ahora algunos dirán que esto esta 
tomando forma y se ve mucho mejor, pero todavía necesitamos un pie de página, cierto? Entonces 
vamos a hacer una juego de capas, que llamaremos piepagina, y adentro pondremos una capa que 
llamaremos fondo_pie 
  

 



 
Ahora tomamos la herramienta de Marco Rectangular (Rectangular Marquee Tool) (M) y 
seleccionamos un área para el pie de página, que tenga la altura que tu quieras, y lo rellenas con 
un color sólido o degradado, la decisión es tuya. Yo voy a usar un degradado con el mismo blanco 
y naranja que use en la capa de barra_nav, después le agregue un trazo de 1 píxel gris obscuro, y 
obtuve algo así: 
  

 
 
OK, ahora si se ve como una plantilla, pero quiero agregar algunos detalles más, antes de ir a la 
parte en la que tenemos que cortar la imagen. Vamos a salvar  (Ctrl +S) lo que hemos hecho hasta 
el momento y vamos a hacer un poco más.  
 
Bien, algunos pueden considerar que la plantilla ya esta hecha, podría ser, podríamos hacer el resto 
usando CSS y mas tarde lo haremos, pero ahora quiero añadir más detalles. 
  
Empieza creando una nueva capa en el juego de capas izquierdo, yo voy a llamar el mió 
fondo_mod. Este va a ser el fondo de los títulos de mis módulos (p.e. menú Principal, Forma de 
Entrada, etc.) 
 

 
 
Ahora toma la herramienta de Marco Rectangular (Rectangular Marquee Tool) (M) y selecciona un 
área rectangular de la altura que tú quieras que sea, que este del lado izquierdo así: 
  

 
 
Ahora decide que vas a hacer con eso, yo voy a escoger un degradado de verde a blanco, para que 
se vea parecido al encabezado. Tú puedes escoger de manera diferente y poner un color sólido o 
simplemente no poner nada. Si quieres un degradado solamente ajusta los colores de frente y 
fondo. 
  



 
 
Después toma tu herramienta para el llenado degradado (Gradient Fill Tool) (G) y llena tu capa 
fondo_mod, en mi casi así es como es la selección, fíjate que estoy empezando un poco más arriba 
de la selección y lo arrastro un poco más abajo. 
  

 
 
Una vez que lo hayas hecho puedes deseleccionarlo (Ctrl + D) y esto es lo que tengo  
 

 
 
Si, yo sé que se ve un poco fuera de lugar, pero estoy seguro que haz visto el plantilla y no se ve 
así, cierto? Bien, vamos a hacer el resto cuando lleguemos a la parte de la programación de este 
manual, así que adelante y sálvalo (Ctrl + S)  
 
OK, ahora lo que necesitamos es un área para nuestro contenido principal, cierto? A pesar de que 
podríamos dejarlo así como esta, yo lo veo muy bonito, pero vamos a adornarlo un poco más, 
después de todo estamos aquí para que aprendas como hacer todo esto, no?. 
 
Continuemos haciendo un nuevo juego de capas, yo llamare el mió cont_princ, y después hago una 
capa dentro del juego y lo voy a llamar fondo_cont. 
  



 
 
Ahora toma de nuevo la herramienta de Marco Rectangular (Rectangular Marquee Tool) y 
selecciona el área para el contenido principal 
  

 
 
Después llénalo con un color sólido o degradado, cualquier cosa que tu creas que se vera bien. Yo 
voy a poner un degradado de blanco a gris claro para que se vea así:  
 

 
 
Se ve bien, no? bien, esta lo bastante bien para se una plantilla pero vamos a agregar una 
pequeña cosa mas, ya que tenemos la mariposa, vamos a poner otra en la parte de debajo de 
nuestra pagina. Así que adelante y salva el trabajo (Ctrl + S). 
 
Ahora vamos a necesitar una diferente variación de la mariposa para ponerla en la parte de abajo 
del área de contenidos, así que abre el navegador y busca una en Stock.Exchange en 
http://sxc.hu/browse.phtml?f=view&id=139603
 
Ya la tienes? Bien, ahora ábrela en Photoshop, y cámbiale el tamaño para que diga 400 píxeles de 
ancho.  
 

http://sxc.hu/browse.phtml?f=view&id=139603


 
 
Después agarra la herramienta de Marco Rectangular (Rectangular Marquee Tool) y selecciónala, 
más o menos así: 
  

 
 
Después cópiala con Editar (Edit) > Copiar (Copy) (Ctrl +C), y ahora cierra este documento y 
regresa a tu plantilla, y una vez que este ahí pega la imagen de la mariposa en la capa cont_prin  
 

 
 
Ahora usando la herramienta del Laso Magnético (Magnetic Lasso Tool) delimita a la mariposa para 
que se pueda borrar todo lo demás, igual que como hicimos con la mariposa del encabezado, si no 
te acuerdas de como hacerlo, solamente recorre lo que has hecho hasta el momento y encontraras 
la respuesta. 
  
Esto es lo que obtuve. 
 



 
 
Un poco grande, no es así? Bien, usando la herramienta de Transformación Libre (Free 
Transform) cambia el tamaño y muévela a la posición que te parezca mejor. 
 

 
 
Ahora vamos a agregar algo de estilo, yo le voy a agregar un poco de brillo exterior (outer glow) 
para resaltarla un poco.  
 

 
 
Ahora voy a poner la configuración de Mezcla (Blending mode) a luz dura y voy a dejar caer el nivel 
de relleno a 25% para que la mariposa se vea un poco transparente. La razón por la cual hago esto 
es que vamos a requerir escribir sobre de ella en algunos casos, y es algo lógico el que el texto 
(contenido) este visible encima de la imagen. 
 



 
 
Ahora se ve así 
 

 
 
OK, llego el momento de lo complicado con la división, y así que adelante y salva tu platilla (Ctrl + 
S). 
 
Ahora voy a intentar explicarte el proceso de dividir. Hay muchas formas diferentes de dividir una 
imagen en Photoshop, pero en este manual nos apegaremos a lo básico, para que puedas tener 
una idea de lo que hace. Para esta plantilla en especifico vamos a usar 12 imágenes (Si, dije 12). 
Fíjate un poco en esta pantalla: 
  
 

 
 
Ves los diferentes colores con números que les corresponden? Esas son las únicas partes de tu 
documento que estaremos usando para construir la plantilla, así que tenemos que exportar esas 
imágenes a un formato que se pueda manejar en Internet como pueden ser .jpg, .gif o .png, y aquí 
es donde el llamado dividir entra en juego. Vamos a usan las divisiones para seleccionar la parte 
que necesitamos para después salvarla para Internet y Photoshop se encarga de crear las 
imágenes necesarias para nosotros. 
 
OK, entonces vamos a empezar con esto, yo explicare todo conforme vayamos avanzando. Primero 
tenemos que establecer algunas guías para ayudarnos a la parte de dividir, y después necesitamos 
crear una división. Así que adelante y pon tu primera guía para la parte izquierda de la plantilla y 
tiene que librar la parte completa (con el trazo gris oscuro) así: 
  



 
 
Después haz lo mismo para obtener el logo (la mariposa y el texto), después la barra de 
navegación, para que este separados en sus propios rectángulos. 
  

 
 
Ahora necesitamos la parte del degradado de nuestro encabezado, pero debido a que tenemos 
esos cuadros ahí, y nuestra platilla tendrá un ancho variable, en esta parte tenemos que arreglarlo 
sin que se vean las uniones. Existen herramientas especiales para acomodarlo en Photoshop, pero 
no vamos a verlas en este manual, así que solo usaremos la imagen de la pantalla para guiarnos 
con ella. Fíjate como se hace, y haz lo mismo. 
  

 
 
Ahora vamos a necesitar una división para separar el lado derecho del resto, hazlo para que se libre 
el trazo gris oscuro, y después pon algunas guías para el fondo del título de los módulos. 
 

 

 
 
Ahora pon dos guías más horizontales, para que puedas capturar los lados izquierdo y derecho de 
manera sencilla. 
 



 
 
Agrega una mas para el pie de página, hazlo para que quede justo en el borde exterior del trazo 
oscuro. 
 

 
 
OK, ahora yo puse 3 guías mas para que quede libre la mariposa de la parte de abajo y la que esta 
a la mita, así puedo capturar la barra de navegación, el fondo de la parte principal y el pie de 
página. Ahora que ya tenemos las guías en su lugar, tomamos la herramienta de Rebanadas (Slice 
Tool) (K) 
 

 
 
después recorta todas las partes necesaria, asegúrate de que tengas el pegado a las guías 
encendido en Ver (View) > Encajar (Snap) (Shift + Ctrl + ;), una vez que lo hagas debes tener algo 
que sea así (nota: Yo he escondido las guías y auto generado las divisiones, para que lo puedas ver 
mejor) El siguiente paso es darle nombres a las divisiones, esto no es algo necesario pero te va a 
facilitar la vida para saber que es cada una de las imágenes cuando llegues a la parte de la 
programación, personalmente me gusta hacer esto, y ya que solamente tenemos 12 imágenes, no 
es mucho trabajo, así que si decides hacerlo toma la herramienta para las divisiones (K) 
 

 

 



 
Después dale doble clic en el número de división, eso te va a abrir un nuevo menú, y ahí tienes una 
opción para los nombres. Ponles nombres, y trata de evitar espacios en blanco, usa guión bajo en 
caso de necesitarlos. 
 

 
 
Ahora que renombraste las divisiones, sería un buen momento de que salves tu documento (Ctrl 
+S) 
 
OK, ahora vamos a continuar y salvarlo para Internet,  
Como con todas las funciones, Photoshop ofrece una amplia gama de herramientas para hacer 
esto, con diferentes configuraciones y opciones ilimitadas, pero esto no será cubierto en el manual. 
Yo utilizare imágenes gif a 256 colores, y ya que tengo pocas imágenes, el tamaño total debe ser 
alrededor de 100 kb. 
  
Para salvar para Internet solamente hay que ir a Archivo (File) > Salvar para Web (Save for Web) 
(Alt + Shift + Ctrl + S) y eso te llevará a otro menú, solamente usa las propiedades que yo use. La 
configuración de .gif con 256 colores no está incluida dentro de las configuraciones 
predeterminadas, así que se tiene que hacer de manera manual. 
  

 
 
Una vez que hayas terminado con las propiedades de los colores, solamente sálvalo y guárdalo en 
algún lugar que te sea fácil de encontrar. Photoshop va a producir todos los archivos necesarios, un 
archivo html y una carpeta (obviamente también las imágenes) 
 
Eso es todo por el momento, esto concluye esta parte del manual. Ya tenemos todas las 
imágenes, ahora es el momento de ponerlas juntas para hacer la plantilla, así que cierra 
el Photoshop y vamos a continuar.  
 
Es hora de empezar a poner toda la plantilla junta, primero vamos a necesitar una forma de ver el 
proceso de diseño mientras vamos avanzando. Existen dos formas para ello, una puede ser hacerlo 
en un servidor remoto, y segundo puede ser tener una copia local instalada y usarla para 
desarrollo. Yo prefiero tener mi trabajo local en vez de subirlo a mi servidor, y eso es lo que estaré 
haciendo en este manual. 



  
OK, Listo? Vamos a empezar instalando una copia de la magnifica herramienta que es el Servidor 
Independiente de Mambo (Mambo Stand Alone Server) creado por www.mambosolutions.com, y 
puedes obtener una copia en http://mosforge.net/projects/msas/ esto te va a permitir correr 
mambo de manera local. 
  
Ahora que he instalado MSAS en el disco C en una carpeta que se llama MSAS. Vamos a abrir 
Dreamweaver y continuar con ello. Aquí esta una imagen de la pantalla de como se ve mi área de 
trabajo. 
  

 
 
El tuyo se puede ver distinto al mió, porque cada quien tiene sus gustos. Realmente no te puedo 
enseñar como se debe establecer un área de trabajo o las preferencias porque esto seria un tema 
extremadamente largo. Así que te las tendrás que ingeniar por tu cuenta. Tampoco te puedo decir 
cuales son los atajos de teclas que debes usar porque he cambiado mis preferencias en múltiples 
ocasiones. Para encontrar cosas te recomiendo que leas algo de la documentación incluida. (Si no 
sabes en donde esta, solamente presiona F1 en tu teclado ☺)  
 
OK, vamos a empezar con lo básico, empieza creando un sitio nuevo (si es que no tienes uno ya). 
Así es como… ve a Sitio (Site) > Nuevo Sitio (New Site) en el menú de definición de sitios, escoge 
la opción Básica y dale un nombre a tu sitio. Yo lo voy a llamar mi_plantilla, dale clic a siguiente 
(next), selecciona Si para la tecnología del servidor y escoge PHP-MySQL y vuelve a dar clic en 
siguiente. En la siguiente opción selecciona la primera que es Editar y probar localmente, entonces 
escoge un fólder en cual vas a guardar tus archivos, de preferencia en el mismo fólder en donde 
guardaste los archivos de Photoshop y las divisiones de las imágenes, esto va a hacer más sencilla 
tu vida, y dale siguiente (next). Para la ruta de raíz usa http://localhost/mambo45/ (a menos que 
hayas cambiado algo en MSAS al momento de instalar. Clic en siguiente (next), selecciona Si, 
quiero usar un servidor remoto. Siguiente, y aquí escoges como te quieres conectar al servidor, yo 
estoy escogiendo Local/Network, entonces necesito poner la ruta en donde se subirán los archivos. 
Muy probablemente será el lugar en donde hiciste la instalación de mambo, en el fólder plantillas, 
en mi caso es C:\MSAS\disk\www\mambo45\plantillas. Si lo vas a hacer de manera remota, 
entonces selecciona FTP e ingresa la información del servidor y la clave de entrada, para el fólder 
usa /mambo_instal_dir/plantillas/ (por ejemplo /public_html/demo/plantillas/ o 
/httpdocs/demo/plantillas/) una vez que lo hayas hecho dale clic a siguientes. Selecciona No para la 
opción de Checar Entrada y Salida (Check In and Out), solamente es útil si requieres de tener el 
historial de los que tu o tu equipo de desarrollo esta haciendo. Por último dale clic a siguiente. 
 
Ahora revisa tu información y dale a Hecho si todo parece correcto. 
 
Correcto, así que ahora ya tenemos la configuración del sitio, entonces hagamos el esqueleto de la 
plantilla, y para ello vas a necesitar un fólder que tenga el mismo nombre que tu plantilla, además 
de que necesitaras dos folders que se llamen “CSS” y “images”. En menú del sitio, ve a Archivo 
(File) > Nuevo fólder (New fólder) y ponle el nombre de tu plantilla (mi_plantilla) 
  

http://www.mambosolutions.com/
http://localhost/mambo45/


 
 
Después crea otro fólder dentro de ese, y llámalo “CSS” y puedes solamente arrastrar el fólder de 
las imágenes sobre el directorio “mi_plantilla”, o copiarlo dentro de el. Después crea dos nuevos 
documentos en el directorio con Archivo (File) > Nuevo (New) y haz uno que se llame 
templateDetails.xml y otro que se llame index.php, y crea uno dentro de la carpeta llamada 
CSS, que se llame template_css.css. Cuando termines, la estructura de tu directorio se debe ver 
así: 
 

 
Ahora tenemos la estructura básica y todas las imágenes, es momento de empezar con 
el código.  
 
Primero copia esto y ponlo en el archivo templateDetails.xml. Todo esto es bastante entendible, 
así que cámbialo con tus propias preferencias. 
 
Nota!  
Los nombres de los archivos de las imágenes tienen que estar ahí si es que quieres 
distribuir la plantilla o si quieres usar el instalador de mambo, solamente asegúrate de 
que refleje las imágenes que vas a usar. 
 

<?xml version="1.0" encoding="iso-8859-1"?> 
<mosinstall type="template"> 
 <name>mi_plantilla</name> 
 <creationDate>06/20/2004</creationDate> 
 <author>allmambo Crew</author> 
 <copyright>GPL</copyright> 
 <authorEmail>plantillas@allmambo.com</authorEmail> 
 <authorUrl>www.allmambo.com</authorUrl> 
 <version>1.0</version> 
 <description>template used in the MOS Template 101 
tutorial</description> 



 <files> 
  <filename>index.php</filename> 
  <filename>template_thumbnail.png</filename> 
 </files> 
 <images> 
  <filename>images/butterfly.gif</filename> 
  <filename>images/designed_by.gif</filename> 
  <filename>images/footer_bck.gif</filename> 
  <filename>images/left_bck.gif</filename> 
  <filename>images/logo.gif</filename> 
  <filename>images/main_bck.gif</filename> 
  <filename>images/mod_title.gif</filename> 
  <filename>images/path_left.gif</filename> 
  <filename>images/path_right.gif</filename> 
  <filename>images/path_var.gif</filename> 
  <filename>images/powered_by.gif</filename> 
  <filename>images/right_bck.gif</filename> 
  <filename>images/top_left.gif</filename> 
  <filename>images/top_var.gif</filename> 
  </images> 
 <css> 
  <filename>css/template_css.css</filename> 
 </css> 
</mosinstall> 

  
Ahora vamos con las cuestiones CSS, toma el código de abajo y pégalo en el archivo template_css.  
 

body, html { 
 margin:0; 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 color: #000000; 
 background-color: #FFFFFF; 
 height: 100%; 
}  
 
tbody {  
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 color: #000000; 
} 
 
/* Propiedades predeterminadas de clases de MOS 
****************************/ 
 
td.pathway { 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 color: #000000; 
 padding-top: 1px; 
 padding-left: 0px; 
} 
 
a.pathway:link, a.pathway:visited { 
 font-family: Verdana, Arial, Helvetica, sans-serif; 



 font-size: 11px; 
 color: #000000; 
} 
 
a.pathway:hover { 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 color: #666666; 
 background-color: transparent; 
} 
 
/* Estilos del menú Principal 
*********************/ 
 
a.mainlevel:link, a.mainlevel:visited { 
 color: #666666; 
 text-align: left; 
 font-weight: bold; 
 border-left-width: 3px; 
 border-left-style: solid; 
 border-left-color: #EBEC9C; 
 padding-left: 5px; 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 line-height: 15px; 
} 
 
a.mainlevel:hover { 
 color: #FFFFFF; 
 text-align: left; 
 background-color: #000000; 
 width: 98%; 
 border-left-width: 3px; 
 border-left-style: solid; 
 border-left-color: #FFFFFF; 
} 
 
a.mainmenu:link, a.mainmenu:visited { 
 color: #000000;  
 font-family: Arial, Helvetica, sans-serif; 
 font-weight: bold; 
} 
 
a.mainmenu:hover, { 
 color: #666666; 
 text-align: left; 
} 
 
a.sublevel:link, a.sublevel:visited { 
 color: #000000;  
 font-family: Arial, Helvetica, sans-serif; 
 font-weight: normal; 
} 



 
a.sublevel:hover { 
 color: #666666; 
 text-align: left; 
} 
 
/* Estilos de módulos 
****************/ 
 
table.moduletable { 
 width: 100%; 
 text-align: center; 
 margin-right: 0px; 
 margin-left: 0px; 
} 
 
table.moduletable th { 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size : 12px; 
 font-weight : bold; 
 color : #000000; 
 text-align : center; 
 background-image: url(../images/mod_title.gif); 
 height: 27px; 
 padding-top: 8px; 
} 
 
table.moduletable td { 
 font-family: Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 font-weight: normal; 
 text-align: left; 
} 
 
/* Estilo para las Encuestas 
**************/ 
 
.poll { 
 color : #666666; 
 line-height : 12px; 
 font-weight: bold; 
} 
 
/* Estilos de las Secciones 
*****************/ 
 
.sectiontableheader { 
 background-color : #CCCCCC; 
 color : #000000; 
 font-weight : bold; 
 font-size: 11px; 
 line-height: 13px; 
} 



 
.sectiontableentry1 { 
 font-size: 11px; 
 background-color : #E4E4E4; 
 border-bottom-width: 1px; 
 border-bottom-style: solid; 
 border-bottom-color: #000000; 
} 
 
.sectiontableentry2 { 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 background-color : #DADADA; 
 border-bottom-width: 1px; 
 border-bottom-style: solid; 
 border-bottom-color: #000000; 
} 
 
.pagenav { 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 font-weight: bold; 
 color: #000000; 
} 
 
a.pagenav:link, a.pagenav:visited { 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 font-weight: bold; 
 color: #000000; 
} 
 
a.pagenav:hover { 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 font-weight: bold; 
 color            : #000000; 
 text-decoration  : none; 
 background-color: #99CC00; 
} 
 
.small { 
 font-size : 11px; 
 color : #666666; 
} 
 
.smalldark { 
 font-size : 11px; 
 color : #333333; 
 text-decoration : none; 
} 
 
.createdate { 



 font-size : 10px; 
 color : #666666; 
 text-decoration : none; 
 font-weight : medium; 
} 
 
.modifydate  { 
 font-size : 10px; 
 color : #666666; 
 text-decoration : none; 
 font-weight : medium; 
} 
 
/* Estilos de Contenidos 
*****************/ 
 
.contentpane { 
 font-size: 11px; 
 color: #000000; 
} 
 
.contentpaneopen { 
 font-size: 11px; 
 color: #000000; 
} 
 
.contentheading, .componentheading { 
 font-family : Verdana, Arial, Helvetica, sans-serif; 
 font-size : 14px; 
 font-weight : bold; 
 color : #FF6633; 
 text-align : left; 
 line-height: 16px; 
 padding-left: 20px; 
} 
 
.category { 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 font-weight: bold; 
 color: #000000; 
} 
 
a.category:link, a.category:visited { 
  color            : #333333; 
  font-weight      : bold; 
} 
 
a.category:hover { 
 color            : #000000; 
 text-decoration  : none; 
 background-color: #99CC00; 
} 



 
/* Estilos de las Formas 
****************/ 
 
form { /* borrowed from mambosolutions.com -- to fix empty space issues */ 
 display:inline;  
 margin: 0px;  
 padding: 0px;  
}  
 
.button { 
  font-family      : Arial, Helvetica, sans-serif; 
  font-style       : normal; 
  font-size        : 10px; 
  font-weight      : bold; 
  background-color : #F0F0F0; 
  color            : #000000; 
  border           : 1px solid #000000; 
} 
 
.inputbox { 
  font-family      : Verdana, Arial, Helvetica, sans-serif; 
  font-size        : 10px; 
  color            : #000000; 
  background-color : #F0F0F0; 
  border           : 1px solid #000000; 
} 
 
/* Ligas 
*********/ 
 
a:link, a:visited { 
  font-size        : 11px; 
  color            : #333333; 
  text-decoration  : none; 
} 
 
a:hover { 
 color            : #000000; 
 text-decoration  : none; 
 background-color: #99CC00; 
} 
 
/* Para títulos de contenido que tienen ligas en vez de Solo Lectura 
****************************************************************/ 
 
a.contentpagetitle:link, a.contentpagetitle:visited { 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 13px; 
 font-weight: bold; 
  color: #000000; 
 text-align:left; 
 } 



 
a.contentpagetitle:hover { 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 13px; 
 font-weight: bold; 
 text-align:left; 
 color            : #000000; 
 text-decoration  : none; 
 background-color: #99CC00; 
 } 
 
.description { 
 font-size: 11px; 
 color: #000000; 
} 
 
/* Estilos para las paginas dhtml */ 
.ontab { 
 background-color: #ffae00; 
 border-left: outset 2px #ff9900; 
 border-right: outset 2px #808080; 
 border-top: outset 2px #ff9900; 
 border-bottom: solid 1px #d5d5d5; 
 text-align: center; 
 cursor: hand; 
 font-weight: bold; 
 color: #FFFFFF; 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
} 
.offtab { 
 background-color : #e5e5e5; 
 border-left: outset 2px #E0E0E0; 
 border-right: outset 2px #E0E0E0; 
 border-top: outset 2px #E0E0E0; 
 border-bottom: solid 1px #d5d5d5; 
 text-align: center; 
 cursor: hand; 
 font-weight: bold; 
 color: #000000; 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
} 
 
.tabheading { 
 background-color: #ffae00; 
 text-align: left; 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
} 
 
.pagetext { 
 visibility: hidden; 



 display: none; 
 position: relative; 
 top: 0; 
 font-family: Verdana, Arial, Helvetica, sans-serif; 
 font-size: 11px; 
 color: #000000; 
} 
 
/* Para modificar el resultado de {moscode}. No le pongas el color! */ 
.moscode { 
 background-color: #f0f0f0; 
} 
 
/* Texto pasado con el parametro mosmsg url */ 
.message { 
 font-weight: bold; 
 font-size : 10pt; 
 color : #ff6600; 
 text-align: center; 
} 

 
después toma este código y ponlo en el archivo index.php 
 

<?php echo "<?xml version=\"1.0\" encoding=\"iso-8859-1\"?".">"; 
?> 
<?php defined( '_VALID_MOS' ) or die( 'Direct Access to this 
location is not allowed.' ); ?> 
<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN"> 
<html xmlns="http://www.w3.org/1999/xhtml"> 
<head> 
<title><?php echo ; ?></title> 
<meta http-equiv="Content-Type" content="text/html; <?php echo 
_ISO; ?>" /> 
<?php include ("includes/metadata.php"); // include keywords, and 
such 
 
if (0) { 
 include ("editor/editor.php"); 
 initEditor(); 
} 
?> 
<link href="<?php echo http://www.allmambo.com;?> 
/templates/mi_plantilla/css/template_css.css" rel="stylesheet" 
type="text/css" /> 
</head> 
<body> 
 
</body> 
</html> 

 
¿Lo tienes? Bien, así que ahora empecemos a poner algunas cosas en el archivo index.php.  
 
Primero vamos a asegurarnos que tienes el archivo index.php, después vas al menú de Insertar, 
Ventana (Window) > Insertar (Insertar) y dale clic al botón para insertar una tabla, algo así: 



 

 
 
Ahora debes de ver un menú como el siguiente, solamente pon la misma información que yo. Estoy 
escogiendo un ancho del 95%, para que la página no este llena completamente con la tabla, 
recuerda que tú puedes escoger cualquier cosa. 
  

Filas (Rows): 1 
Columnas (Colums): 2 
Ancho (Width): 95 Por ciento (Percent) 
 
 
 

Después con la tabla selecciona, que ya lo estará predeterminado. Si no lo está, dale clic a uno de 
los bordes y estará seleccionada. Abre la herramienta de propiedades, yo tengo la mía en la parte 
inferior, Ventana (Window) > Propiedades (Properties) (Ctrl + F2) y selecciona que la tabla este 
centrada: 
 

 
 
Ahora en la celda de la derecha de la tabla que acabas de crear, asegúrate que este seleccionada. 
  

 
 
Ahora ve al menú de insertar y dale clic al botón de Insertar Imagen: 
 

 
 
Después inserta la imagen superior izquierda, o como la hayas llamado, usa la opción de Relativo a: 
Documento (Relative To: Document) 
 

 
 
Ahora con la celda con la imagen todavía seleccionada, pon que el ancho sea del mismo tamaño 
que la imagen, en mi caso es de 151 píxeles, así que solamente le pongo 151, y la altura la 
dejamos vacía. 
 



 
 
Ahora selecciona la celda de la derecha, y en las propiedades selecciona la alineación vertical en 
Superior (Top), que significa que va a alinear todo con la línea superior. 
 

 
 
Ahora inserta dos tablas en esa celda, que sean ambas de 100% de ancho, la primera debe ser con 
2 columnas y la otra con 3 columnas, para que el acomodo de la página se vea como algo así: 
 

 
 
Ahora pon la imagen de tu logo en la celda superior izquierda de la tabla, y pon el ancho de la 
celda del mismo tamaño que la imagen, en mi caso es de 279 píxeles. A continuación vamos a 
poner el fondo de la celda de la derecha, y esto se hace seleccionando encima de ella y en las 
propiedades selecciona el fólder al lado de la celda para el Fondo (Background=Bg), y en el menú 
que se abre, selecciona la imagen correspondiente, la mía se llama barra_nav.gif 
 

 
 
Ya que lo hayas hecho se debe ver como algo así 
 

 
 
Después necesitamos hacer las imágenes para el “camino”. Si hiciste lo mismo que yo en 
Photoshop, debes de tener 3 imágenes para eso: izquierda, variable (una parte que se estira), y 
derecha. Así que adelante y ponlas en la parte que corresponden, recuerda asignar un valor para el 
ancho de las celdas que quieres que se mantengan iguales sin importar el ancho de la pagina, esto 
es muy importante si no quieres que tu plantilla se vea toda distorsionada y desordenada. después 
agrega 2 tablas mas, ambas de 95% de ancho y centradas, con 3 columnas. Una de ellas va a 
servir para el contenido y la otra para el pie de página. 
  
Haz que la primera tenga las celdas con posición centrada y superior, además de ponerle el ancho 
de columna a las celdas izquierda y la derecha. Haz que el ancho sea del mismo tamaño que el 
fondo de las celdas izquierda y derecha, las mías son de 151 píxeles. La celda central déjala vacía 
(el que no tenga valor de ancho quiere decir que se estirara para ajustarse al ancho de la ventana 
del navegador). La tabla del pie de página realmente no importa, pero ya que voy a poner 2 



imágenes ahí que son las de “hecho con” y “hecho por”, necesito tener 3 columnas, puede ser que 
tu solamente necesites 1, dependiendo de lo que quieras hacer. 
 
Una vez que lo hayas hecho debes de tener algo parecido a esto: 
 

 
OK, ahora coloca el fondo de las celdas izquierda y derecha en su lugar, y después coloca las 
imágenes derecha e izquierda del pie de página (si tienes alguna), si no las tienes entonces pon 
solamente la imagen del fondo en su lugar. Una vez que hayas hecho esto debes terminar con algo 
parecido a esto: 
 

 
 
OK, ahora antes de empezar a llenar tu página con el contenido del Mambo, necesitamos hacer 
unas cuantas cosas más. 
 
Primero vamos a necesitar agregar una clase CSS al contenido central. Esto se puede hacer 
seleccionando la opción de pantalla dividida con el botón de las vistas de código y diseño 
 

 
 
Eso te va a permitir ver al mismo tiempo el código y el diseño, así que selecciona la celda y la veras 
en la pantalla del código, en la vista de código agrega (class=”content”) a la etiqueta <td> 
para que al final se vea así <td class=”content”>  
 

 
 
Ahora que ya tenemos eso cubierto, vamos a poner otra tabla en la celda del contenido, yo la estoy 
haciendo del 98% de ancho con una columna y una fila. Ya que hiciste la tabla ahí, necesitas 
ajustarla para que su posición dentro de la celda sea hacia arriba, y agrégale la etiqueta de clase 
(class=”content”) a la tabla, recuerda que esto se necesita que este dentro de la etiqueta 
<table>, así que debe verse así <table width="98%" border="0" cellspacing="0" 
cellpadding="0" class="content"> 
  
Asegúrate de tener la tabla correcta seleccionada ☺ 
 
Después selecciona la tabla completa que tiene los módulos izquierdo y derecho junto con el 
contenido y agrégale una clase (class=”100”) a la tabla para que se vea así <table 
width="95%" border="0" align="center" cellpadding="0" cellspacing="0" 
class="100">  
 



Ahora que ya tenemos nuestra estructura básica es momento de llenarla con el contenido, pero 
antes de hacerlo vamos a agregar algunas clases al archivo CSS, recuerdas que las definimos en la 
celda de contenido y en las tablas? Ahora es un buen momento para agregarlas al archivo 
template_css.css, así que adelante y abre el archivo. Una vez abierto agrega las 3 clases dentro de 
él. 
 

table.100 { 
 height: 1%; 
} 
 
table.content { 
 background-image: url(../images/mariposa.gif); 
 background-repeat: no-repeat; 
 background-position: right bottom; 
 height: 100%; 
 padding-top: 20px; 
} 
 
td.content { 
 background-image: url(../images/fondo_principal.gif); 
 background-repeat: repeat-x; 
 background-position: left bottom; 
} 

 
Ahora, la primera table.100 solo tiene una altura de 1%, y esto es para que la tabla tenga un 
valor de altura asignado, lo cual es necesario para la alineación de la mariposa. 
 
table.content tiene la imagen de la mariposa que quería agregar en la parte de debajo de mis 
páginas, así que la tuya lo necesita para apuntar a la imagen apropiada, en mi caso es 
mariposa.gif, la altura es de 100% para que la mariposa siempre este en la parte de abajo, sin 
importar si el contenido llena la página o no. 
 
td.content tiene la imagen de fondo que en mi caso es fondo_principal.gif, esta puesto para que 
este hasta abajo y que solamente se repita solamente en el eje X (horizontal). 
 
Una vez que hayas terminado puedes salvar el archivo template_css.css. 
 
Lo tienes? Bien, ahora vamos a empezar a poner las etiquetas del contenido a la plantilla, empieza 
yendo a la celda izquierda donde los módulos de la izquierda se van a poner y agrega el siguiente 
código: 
 
<?php mosLoadModules ( 'left' ); ?>  
<?php mosLoadModules ( 'user1' ); ?>  
 
Para que todo completo se vea así: 
 

<td width="151" background="images/left_bck.gif">  
<?php mosLoadModules ( 'left' ); ?> 
<?php mosLoadModules ( 'user1' ); ?> 

</td> 
 
Después agrega estas dos líneas al lado derecho, que son las que muestran los módulos de la 
derecha 
 



<?php mosLoadModules ( 'right' ); ?>  
<?php mosLoadModules ( 'user2' ); ?>  
 
Para que el código completo se vea así: 
 

<td width="151" background="images/right_bck.gif">  
<?php mosLoadModules ( 'right' ); ?> 
<?php mosLoadModules ( 'user2' ); ?> 

</td> 

 
 
Lo tienes? Magnífico, ahora unas cosas más. Se necesita hacer el “camino” y el contenido. A pesar 
de que existen muchas mas etiquetas que se pueden usar en Mambo, solamente vamos a estar 
usando las básicas para este manual. Agrégale la siguiente línea a la celda para el “camino”, fíjate 
que también le agregue una clase a la celda para hacer lo mismo que con el resto de las celdas. 
 
<?php include "pathway.php"; ?>  
 
Así que el código completo se ve así: 
 

<td background="images/path_var.gif" class="path"> 
<?php include "pathway.php"; ?> 

</td> 
 
Lo siguiente es agregar la etiqueta del cuerpo principal, dentro de la celda en donde ira el 
contenido: 
 
<?php include_once ("mainbody.php"); ?>  
 
Y así se ve completo: 
 

<td valign="top"> 
<?php include_once ("../mainbody.php"); ?> 

</td> 
 
Y eso es todo para que la plantilla se llene con el contenido, antes de que puedas probar tu plantilla 
hay una cosa más que se necesita hacer. 
 
Primero se tiene que poner algo más de información para la ruta de las imágenes, para que Mambo 
pueda encontrar las imágenes de la plantilla, sin importar en donde este instalado. Para hacer esto 
asegúrate de tener el archivo index.php seleccionado en el menú de tu sitio, y ve a Editar (Edit) > 
Buscar y remplazar (Find and Replace) (Ctrl + F) y con eso te va a aparecer este menú: 
 

 
 
Usa los parámetros que yo tengo acá arriba y la búsqueda la debes hacer de: 
 
images/  



 
Y reemplázalo con: 
 
<?php echo $mosConfig_live_site;?>/plantillas/mi_plantilla/images/  
 
Asegúrate de que (mi_plantilla) es el nombre del fólder que estas usando para la 
plantilla. 
  
Una vez que tienes todos los parámetros en su lugar, solamente dale clic a reemplazar todo y salva 
el archivo. Una vez que lo hayas hecho, ya estas listo para usarla, puedes subir tu plantilla a tu 
servidor local o remoto y probarla. 
 
Eso es todo, ya terminaste, el resto del proceso es modificar el archivo CSS para reflejar mejor tus 
colores, tamaños, menús, etc. Pero eso es otro manual que puedes encontrar AQUÍ. 
 
Si tienes alguna pregunta, no tengas miedo de preguntar, usa los foros (para acceder a foros en 
español, accesalos en Mambohispano). Si encuentras algún error, o algo que no esta lo 
suficientemente explicado, házmelo saber para poder corregirlo. 
 
Puedes bajar la plantilla y los archivos de Photoshop en la sección de Descargas de 
Allmambo.com 
 
Espero que hayas disfrutado este manual, tanto como yo disfrute escribiéndolo ☺ (Y yo 
traduciéndolo ;-) ) Buena suerte y sigue haciendo plantillas, la comunidad de Mambo 
nunca va a tener suficientes. Y si encontraste este manual de ayuda y tienes algunos 
dólares extras, considera la opción de hacer una donación. 
 
Si quieres ver el manual en ingles completo en línea, visita www.allmambo.com  

http://www.allmambo.com/index.php?option=content&task=category&sectionid=1&id=11&Itemid=2
http://www.allmambo.com/index.php?option=com_simpleboard&Itemid=33
http://www.mambohispano.org/foros
http://www.allmambo.com/

